UG-2023-08 Infineon

EVAL-2ED2742S01 GM1 for Battery Powered
Applications Evaluation Kit User Guide

Used for Consumer and Outdoor Power Tools, Robotics, Drones, e-Bikes

About this document

Scope and purpose

The purpose of this document is to serve as an user guide for evaluating the new 160 V half bridge SOI gate
driver from Infineon Technologies - 2ED2742S01G. EVAL-2ED2742S01 GM1 for Battery Powered Applications
(BPA) evaluation kit consists of a three-phase inverter power board with the 160 V rated 2ED2742S01G (in 3 x 3
10-Lead DFN package) half bridge gate driver driving six 150 V rated OptiMOS™ MOSFETs BSCO74N15NS5 (in 5 x
6 Super SO8 package). The power board has a M1 connector that is used to interface with iMotion™ Modular
Application Design Kit (MADK) control card - EVAL-M1-101T. This control card is powered by IMC101T-T038
iMOTION™ Motor Control IC featuring advanced Motor Control Engine (MCE), that enables state-of-the-art
Sensorless Field Oriented Control (FOC) without need for any coding. IMC101T-T038 is a part of the iIMOTION™
IMC100 series, which is the next generation of well established iMOTION™ motor control IC platform dedicated
to field-oriented control of PMSM (BLDC) motors. The evaluation kit comes with both EVAL-2ED2742501 GM1
and EVAL-M1-101T including a USB connector to interface with a laptop having MCE Designer software.

Intended audience

Direct Current (DC) based Motor (BLDC, Servo, Stepper) control system engineers designing battery operated
consumer power tools, outdoor power tools, robotics systems, drones, electric bikes and Small Home
Appliances such as hair dryers, vacuum cleaners.

Evaluation Board

This board is to be used during the design-in process for evaluating and measuring characteristic curves, and
for checking datasheet specifications. This board must be used in laboratory environment by trained power
electronic engineers adhering to safety requirements.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.
Note: Boards do not necessarily meet safety, EMI, quality standards (for example UL, CE) requirements.

Ordering information

Base part number Package Standard pack Orderable part number
Form Quantity

EVAL-2ED2742501 GM1 MADK EVAL Boxed 1 EVAL2ED2742S01G
BPA EVAL Kit
2ED2748S01G 3x3mm

Tape and Reel 2,500 2ED2748S01GXUMAL

DFN10

EVAL-M1-101T MADK EVAL Boxed 1 EVALM1101TTOBO2
BSCO74N15NS5 PG-TSON-8 | Tape and Reel 5000 BSCO74N15NS5ATMAL
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Important notice

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).

Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards
has been tested by Infineon Technologies only as described in this document. The design is not qualified
in terms of safety requirements, manufacturing and operation over the entire operating temperature
range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products and are solely intended for
evaluation and testing purposes. They shall not be used for reliability testing or production. The
Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.

Itis the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.

The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.

Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems

Table1l Safety precautions

Warning: The DC link potential of this board is up to 160 VDC. When measuring voltage
waveforms by oscilloscope, high voltage differential probes must be used. Failure to do
so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R BB
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1 The board at a glance

The evaluation board EVAL-2ED2742S01 GM1 is powered by a DC source in the range of 24 V to 72 V and
provides a three-phase output to power upto 500 W (without heat sink) to 1000 W (with heat sink) BLDC motors
operating at a nominal 24 V DC bus voltage. It contains the new 160 V, half bridge gate driver IC 2ED2742S01G,
the OptiMOS™ BSCOT4N15NS5, bus capacitors, a single shunt for current sensing, and other peripheral circuits.
The board can also be powered up from a 10.8 Vto 96 V Li-ion battery pack. Before connecting the battery pack,
ensure reverse polarity protection and inrush protection is provided to EVAL-2ED2742S01 GM1 board.

1.1 Scope of delivery

The EVAL-2ED2742S01 GM1 evaluation board is delivered along with an iMOTION™ 2.0 M1 interface connector
and EVAL-M1-101T control card.

The package also contains a DC-DC buck converter with integrated MOSFET to provide auxiliary power supply
of 12 V and 3.3 V; a single shunt for current sensing and overcurrent protection. The board can be operated
directly with the DC power supply without any additional components. An inrush current limiter is
recommended if operating directly from a battery source.

1.2 Block diagram

Figure 1 shows a typical application diagram of EVAL-2ED2742S01 GM1 for driving a BLDC motor. The system
adopts a single-shunt configuration, which is prevalent for current BLDC motor drive applications.

WVIN
Cin
GND 2ED2742501G
° 1 VIN ,
a1 J a3 J as J
Three HOA J:l Bl Jr_‘i p3 Jﬁ os
. HOB , - wk
Microcontroller Half—Brldge Q2 :jrs'l aa ve J HOQG - 5 N'IB[;_EC?R
Gate Driver oa | + o J% T- oa JE =
LOB LoC

‘ Ower Current
Protection

Note: Board DC input at VIN, OUTPUT at BLDC MOTOR
Figure 1 Simplified application block diagram of EVAL-2ED2742S01 GM1

The 2ED2742S01G is a 160 V SOI based gate driver designed for three phase BLDC motor drive applications.
Integrated bootstrap diodes are used to supply the external high sides charging bootstrap capacitors.
Protection features include under voltage lockout, over current protection with configurable threshold, fault
communication and automatic fault clear.
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The functional blocks of EVAL-2ED2742501 GM1 BPA Evaluation Kit are presented in Figure 2

infineon
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Figure 2

1.3 Main features

The main features of EVAL-2ED2742501 GM1 include:
e Nominal DCinputvoltage of 48V

Functional blocks of EVAL-2ED2742501 GM1 BPA Evaluation Kit (top view) w/o heatsink

e Design for maximum 500 W motor power output (1000 W with added heatsink / forced air cooling)

e Single shunt for current sensing

e Sensing of DC-link voltage

e +12Vand +3.3Vauxiliary power supplies on the board

e Ml interface compatible with the iMOTION™ control board

* Integrated over-current protection inside 2ED2742S01G with selectable Vger threshold
* Integrated shoot-through protection with built-in dead time

14 Board parameters and technical data

The key specifications of EVAL-2ED2742S01 GM1 are listed in Table 2.

Table 2 Specifications of EVAL-2ED2742S01 GM1
Parameter Symbol | Conditions : Value Unit
Min. | Nom. | Max.

Input

Input voltage Vin DC voltage 24 48 72 |V

Input current Iin Input current - - 25 |A
Output

User Guide 7 Revision 1.00
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. Value Unit
Parameter Symbol | Conditions .
Min. ‘ Nom. ‘ Max.

Input

Output current lout RMS phase-out current - - 20 |A
Additional heat dissipation is
Output power Pour needed (e.g. heat sink, forced air 150 | 500 | 1000 |W
cooling)

Switching frequency
Inverter carrier frequency ‘ Fsw ‘ ‘ - ‘ 23 ‘ - ‘ kHz
Auxiliary power supply
Fan power supply - 12 - v
Controller power supply - 3.3 - v

System environment
Ambient temperature ‘ ‘ With adequate cooling method ‘ - ‘ 25 ‘ - °C

PCB characteristics

L Length - 120 - mm
Dimensions W Width - 60 - mm
H Height - 25 - mm

Layer - 4 -

PCB thickness - 1.6 - mm
Copper thickness - 4 - oz.
Material FR-4, RoHS-compliant

Note: The evauation board is designed to evaluate the parameters of 2ED2742S01G half bridge gate driver IC.
The board does not have over temperature protection and care should be taken System and functional
description

1.5 Getting started with EVAL-2ED2742S01G

To run the motor system, a combination of the power board EVAL-2ED2742S01 GM1 and a matching iMOTION™
control board (e.g., EVAL-M1-101T) are required. This chapter explains how to set up the system and get started
with the IMOTION™ development platform.

The power board EVAL-2ED2742501 GM1 can run a BLDC motor by connecting to the iMOTION™ 2.0 control
board EVAL-M1-101T through an M1 interface. The system connection is shown in Figure 3, and the test results
are listed in Section 3.1.

User Guide 8 Revision 1.00
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MADK Board 2ED2742S01G Eval Board
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Figure 3 The system connection for running a BLDC motor with Heatsink

1.5.1 The iMOTION™ control board

The latest IMC101T-T038 MCE software package can be downloaded from www.infineon.com/imotion-
software.

With EVAL-M1-101T and the latest software, connect your PC to the control board via a USB cable to program

and tune it.

1. Connect EVAL-M1-101T’s M1 20-pin interface connector J2 to the EVAL-2ED2742S01 GM1 board connector
J3.

2. In the MCEWizard, enter the system and operating parameters of the target motor and the hardware
parameters of the evaluation board. This data is used for calculating the digital parameter set of the
controller, representing the complete motor drive system.

3. Go to the Verify & Save page and click Calculate Parameters. Then, save the drive parameter set into your
project directory by clicking Export to MCEDesigner file (.txt) (see Figure 6). This saved drive system
parameter file will be used later by the MCEDesigner. Refer to Section 2.1.4 or the MCEWizard user guide for
more information.

4. Connect motor phase outputs (J2 on the EVAL-2ED2742501 GM1 board) to the motor.

5. Connect DC input to the power input connector (J1 on the EVAL-2ED2742501 GM1 board), then power on
the system. Note the

6. Startthe MCEDesigner tool.

Click File > Open to open the MCEDesigner default configuration file (.irc) for the IMC101T-T038 controller
(IMC101T_Vxxx.irc). The IMC101T_Vxxx.irc file is included in the IMC101T-T038 MCE software package.

8. The MCEDesigner should automatically connect to the EVAL-M1-101T control board using the default COM
port (indicated by a green circle next to the “COMx Up” status in the bottom frame of the MCEDesigner
GUI). If the connection cannot be established, change the COM port as follows:

a) Open the System Page window.
b) Click Preferences > Connection > Connect using.
c) Choose one of the other available COM ports from the drop-down list.

9. Program the system parameters into the internal SRAM of the iIMOTION™ IC using the following steps:
a. Click Tools > Programmer and select Program Parameters.
User Guide 9 Revision 1.00
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b. Browse and select the System Drive Parameters file created in step 3. See Section 2.1.4 for more
information.
10. Start the motor by clicking the green traffic light button in the control bar. To stop the motor, click the red
traffic light button in the control bar.

1.5.2 iMOTION™ development tools and software

The EVAL-2ED2742S01 GM1 evaluation board can run a BLDC motor when connected to an external control
board EVAL-M1-101T. Users must configure the iMOTION™ development tool and software according to the
system and BLDC motor parameters.

The MCEDesigner and MCEWizard are based on MCEDesigner v2.3.1 and MCEWizard v2.3.1 and can be
downloaded together with supported files from http://www.infineon.com/imotion-software.

A review of references [10] to [16], on page 45 will provide a deeper understanding of the overall iMotion™
ecosystem.

1.5.3 MCEWizard setup overview

Use the MCEWizard to configure the parameters for the evaluation board or motor. Figure 4 shows the Welcome
page of the MCEWizard. Here, users can select the control board or power board from a drop-down list. Infineon
releases new control and power boards regularly. Therefore, it is possible that some of the latest power boards
have not been pre-configured in the MCEWizard tool and cannot be selected from the drop-down menu. In that
case, users can select another power board (as similar as possible) and follow the setup steps in the MCEWizard
by entering parameters specific to the power board chosen. Please refer to the application note of the
corresponding power board for additional information.

After selecting the modular application design kit (MADK) control board and the power board, click Next in the
right-hand bottom corner of the Welcome page to start the MCEWizard system setup process.

User Guide 10 Revision 1.00
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Q MCEWizard 2.3.0.1 - C/Users/wchu1/WDC/IPC/ISD/IPM/imotion/iMotion 2/SiC board/Golden age motor.mc2 = X

File JumptoPage Help

Welcome Page -

iMOTION™ 2.0 System Configuration Wizard

Using System Configuration File:

EVAL-M1-101T-05-65D.mc2 Infmeon

P

This motor control system is an
evaluation kit for complete inverter-
controlled motor drive applications
based on EVAL-M1-101T iMOTION
MADK controler board (based on
IMC101T-T038 iMOTION controller)
and EVAL-M1-05-65D MADK inverter
board (based on IRSM505-065DA2
CIPOS Micro IPM).

Following two options are available. ~ —
If no hardware change is done on this
board and there is no plan to change
default control settings:

Select > Default Hardware and Control
Settings.

Get MADK Hardware Info Get iMOTION™ Info

Open System Configuration File I
Save System Configuration File |
Next

Previous

Figure4  Welcome page of the MCEWizard

The iIMOTION™ system enables users to easily test different combinations of control and power boards with
their motors. Users should be familiar with system-level parameters related to the motor used. There are a
limited number of parameters specific to the control board or power board hardware. Table 3 lists the
hardware parameters specific to the EVAL-2ED2742S01 GM1 power board for MCEWizard setup. Similar tables
are available for each control board in its application note. A combination of data in this table and the
corresponding table of the control board provides sufficient information to set up the motor drive system
quickly.

Table3 MCEWizard setup overview table

Parameter Value

Control board selecting EVAL-M1-101T for example

Motor 1 shunt configuration Single shunt

Controller supply voltage +3.3V

Max DC bus voltage 36V

DC bus sensing high resistor 300 kQ

DC bus sensing low resistor 4.7kQ

NTC temperature shutdown value Refer to the control board’s application note [6]

Gate sense low-side devices High is true

Gate sense high-side devices High is true

Motor 1 current input scaling Calculated in the corresponding section of the
control board’s application note [6]

After all the MCEWizard questions are answered, the Verify & Save page opens (see Figure 5.)
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(infineon

n MCEWizard 2.3.0.1 - C\O1-Workspace\02-2ED1324 + IGETY module - Jinsheng Eva\03-Firmware\Firmware debugiHig... - x
File JumptoPage Help
|‘|.'erify & Save Page - |
Verify Parameters
|Calculate Parameters| |Displa'y Parameters Rﬂsults| |E)qmrl to MCEDesigner File (.b:t)|

Double-Click an item to JUMP to its associated question

Figure5 Verify & Save page of the MCEWizard.

Click Calculate Parameters and then Export to MCEDesigner File (.txt) to save the parameter file. This file

will be used by the MCEDesigner in the next steps.
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1.5.4 MCEDesigner setup overview

The MCEDesigner is a user interface to access or debug the control board. Open the MCEDesigner and then
open the IMC101T_xx.irc file. The main display page for EVAL-M1-101T opens, as shown in Figure 6.

jg Systern - EVAL-2ED1324512PM1_HighPower.irc - MCEDesigner Ver 2. 3. 0. 1 - Infineon Technologies — O x

File View Preferences Tools Window Help
EERE o
" | System - EVAL-2ED1324512PM1_HighPower.irc =
W C\O1-Workspace\0 ~
= Monitor Definiti
#— B FluxrAngle &
# @ MotorSpeed
w— B lu & Iv_Fast
#— B Ju & v_Slow
o B u & Flx_M
B Flx_Q & Flx _t
#— B u & MotorS
o @ lu & Trg v
< >

g
o

B CAD1-Workspace\0 A~
=—{& User Applicatior

=M Start Motor
=8 Stop Motor
# M Drive Status
M Emergency £
=8 Configure M
B Reference Sg

+— B Clear Faults
# @ VYF Diagnost
# B Read DC Vol

b B Cuiernnt L

< >

For Help, press F1 IMC101T COMS Down |[Trig Idle | ® Motor1 Ini * Systemn Inactive

Figure6 MCEDesigner’s main display for EVAL-M1-101T

After the drive system parameter file has been programmed into the IMC101 controller, and the motor drive
system powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change
the motor speed, modify drive parameters, and perform many other functions. Please refer to the MCEDesigner
documentation [8] for more details.

1.6 Description of functional blocks

The motor inverter in EVAL-2ED2742S501 GM1 hardware design is implemented by the new 160 V SOI three half
bridge gate drivers 2ED2742S01G and six OptiMOS™ 150 V N-Channel MOSFETs - BSCO74N15NS5. The auxiliary
power supply is derived from a high voltage DC-DC buck converter providing 12 V followed by a LDO providing
the 3.3 Vrequired to power the iMotion™ IMC101T microcontroller.

User Guide 13 Revision 1.00
2023-06-01



o~ _.
EVAL-6ED2742S01Q for Battery Powered Applications Evaluation Kit ‘ |n f| neon

User Guide
The board at a glance

1.6.1 Overview of 2ED2742S01G

Figure 7 shows the functional block diagram of 2ED2742S01G. For more information such as static and dynamic
electrical characteristics of the gate driver, please refer to the datasheet of 2ED2742S01G.

-

vss [1 [ 7] vB
: = oV
= DETECT

= r
Ne [10] 2ED274x501G Pulse R Q 8| HO
vss / +—| Filter S
com | [9] vs

i [2Z—y—| B> LEVEL "
- = SHIFT [ Pulse BS diode %
i Generator I~
I - [
Deadtime & shoot |7 - T 6] VvCC

through prevention uv

DETECT ’-E
\_Dvss / com Delay +—5] o

uN [3}— LEVELSHIFT|  |Match
i + a]com

Exposed
PAD E|ﬂ_l vss

=

N/

Figure 7 Functional block diagram of 2ED2742S01G

The main features of 2ED2742S01G include:

e Bootstrap voltage (VB node) of +160 V

¢ Floating channel designed for bootstrap operation

e Integrated low Ro, ultra-fast bootstrap diodes

e Independent under voltage lockout for both high and low side
e Integrated shoot-through protection with built-in dead time

e 3.3V,5Vinputlogic compatible, outputs in phase with inputs
e Available in small footprint DFN 10 lead, 3x3 mm package

e 2.5kVHBM ESD, RoHS compliant
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Table 4 Absolute maximum ratings of 2ED2742S01G

Symbol Definition Min. Max. Units
Vs High-side floating well supply voltage (Note 1) -0.3 160
Vs High-side floating well supply return voltage -0.3 140
Ves Bootstrap supply range -0.3 20
Vo Floating gate drive output voltage Vs-0.3 Ve+0.3
Vee Low side supply voltage -0.3 20 v
Vio Low-side output voltage -0.3 Vec+0.3
Viosicin Logic input voltage (HIN, LIN) -0.3 5
COM Low side power ground return -5.0 +5.0
dvs/dt Allowable Vs offset supply transient relative to COM — 50 V/ns
Package power
Po dissipagti:n @ Ta<+25°C >x5mm QFN-32 3 W
Rth,, | nermalresistance, 5 x 5mm QFN-32 41 oC/W
junction to ambient
T, Junction temperature — 150
Ts Storage temperature -50 150 °C
T, Lead temperature (soldering, 10 seconds) 260

Note 1: In case VCC > VB there is an additional power dissipation in the internal bootstrap diode between pins VCC and VB.

1.7 Shoot-through protection

The 2ED2748S01G is equipped with shoot-through protection circuitry (also known as cross-conduction
prevention circuitry). Figure 10 shows how this protection circuitry prevents both the high- and low-side
switches from conducting at the same time.

Normal Operation Abnormal Operation
; I
HIN ! I—
|
\ |
LIN | |
L I
1 y
HO \ ||
l R E—
\ [
| |
LO I \
] |

Figure 10 Illustration of shoot-through protection circuitry
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1.8 Short-Pulse / Noise rejection filters

This device’s input filter provides protection against short pulses (e.g., noise) on the input lines. If the duration
of the input signal is less than tew, the output will not change states. Example 1 of Figure 21 shows the input
and output in the low state with positive noise spikes of durations less than tqn; the output does not change
states. Example 2 of Figure 21 shows the input and output in the high state with negative noise spikes of
durations less than tqin; the output does not change states.

IN t
— FILIN
. [ Ll
=3
IS
S ouT
L
IN
ﬁ |_|tFIL,IN u |_|
a
€
g ouTt
L

Figure11 Noise Rejecting Input Filters

1.8.1 Overview of BSCO74N15NS5

The BSCO74N15NS5 is a 150 V rated N-Channel OptiMOS™ 5 power MOSFET. It was mainly chosen for its 5 x 6
Super SO8 package and its excellent gate charge x Ros on) product Figure of Merit (FOM).

Figure 22 shows the key features of BSCO74N15NS5. For more information about the MOSFET, please refer to
the datasheet of BSCO74N15NS5.

Parameter Value Unit

S1
[ 118D [0 150 v

Sz [] =] 7D | Rps(on)max 7.4 mQ
S3 [ —j 6D ID 1 14 A

Qoss 116 nC
G4 [] L] sD

er 23 nC

TSON-8-3

/ ’6“ 2

2
1

5
a
3

Figure 12 Key features of BSCO74N15NS5
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The typical gate charge characteristics and typical capacitances of BSCO74N15NS5 are shown in Figure 23.
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-...\‘\
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10° ™
E FCoss
o \\
N
10? AN
~
N
it
\"‘--...______
10! Crss
0 25 50 75 100 125 150
Vos [V]

C=f(Vbs); Ves=0 V; f=1 MHz
Figure 13 BSCO074N15NS5 typical characteristics

Areview of references [8] and [9], on page 45 will provide a deeper understanding of the features of OptiMOS™ 5
technology and its benefits in low voltage high power motor drive applications.
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2 System design

This chapter covers the hardware design of EVAL-2ED2742S01 GM1 in detail. Users can modify the circuit or re-
select the component values based on actual applications in the field.

2.1.1 DC-link voltage measurement and inrush current limiter

Bus capacitors should be large enough to stabilize the bus voltage.

|

[ [

[Fsa [Fs

| ]

ZEE]'\.

Q J_ll::_ W | oo

-1‘.?]:Jl T -
Figure 14 Bus capacitor configuration and DC bus sensing

2.1.2 Inverter section using OptiMOS™ 5 BSC074N15NS5

The inverter section is implemented using BSCO74N15NS5 as shown in Figure 15. It is a three-phase inverter

bridge section with Infineon’s OptiMOS™ 5 N-channel MOSFETs. R40/ R41 (in parallel) are single shunt for
current sensing.

- i J7 R4 - 38 R15 "
P 1_\-_-1415‘3=_7_—.- o | [_\'_-1413'5'}'_'.'_:' or |,
| o Sop | o S |
QLT 18 2R Q!T R19 2R Q3‘j
= xi1s 2 x30
HO HO3
T 72
L 4 L
1 L 3 L 4 L 2
1 L T, B 4 ]

€21

AR
10onF 11 C20

g
1000 1T

i il I T
Figure 15 The diagram of the BSC074N15NS5 based inverter section with single shunt current sense
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2.1.3 Drive circuit with 2ED2742S01G
The configuration of 2ED2742S01G is shown in Figure 16.

The capacitor C33 (C34, C35) is used as bootstrap capacitor to provide the necessary floating supply voltage
VBS. Thanks to the bootstrap diode integration in 2ED2742S01G, an external bootstrap diode is not needed.

The fault-clear time setup is based on the datasheet of 2ED2742S01G. The main feature of 2ED2742S501G
designed with Infineon’s SOI technology is its tolerance in terms of negative transient voltage in inductive load
applications. 2ED2742S01G can tolerate repetitive negative transient voltage of up to 15V (pulse width up to
100 ns).

x4
DC+
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DUIBWIE IR il 11T E WR], |~ IHLETTE WR], 2
T } } e e
RIT 2R o RIE 2R o RIT IR i

Qi Q2 @

g =) 230 o 232

1000F 1 C20
T00aF 17 C21

T00aF |1 C19
(=]

7 k’]' (
& VE 2 oy lcu o 1 H ST : :
|: PWMVE 2| e ’ o0 h-E Zal IN4LHWTE TR P walwF o BRf, IHLETTE e |,
T vy 2 1 R IR ‘H} 5 R :} 736 2R :}
e B T ol i 5 ) Q|
D PRMVL 3 f o ’ Pl '[ t‘o'l K R L c32 Py Iﬁg&;s_ox
“' i o com |-+ 14 T
et Ne2
1EDY74; = o
[SELINT i o0 g] BGHD SGND
B —t
sovpei] vee vsg |- ol R43
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X0 PWMWH l
PWMUL 3, f ;po ’ L0 b= F_CEOJ]

Figure 16 Drive circuit design with 2ED2742S01G

2.1.4 Overcurrent protection

The overcurrent circuit is shown in Figure 15. To save power loss of the shunt resistor, the Rqwunt value is set as 10
mQ by using two 20 mQ / 2 W surface-mounted devices (SMD) resistors (R40/R41) and low equivalent series
inductance (ESL) in parallel. In the design, the target current for overcurrent protection (loce) is 25 A. The
overcurrent threshold of the ITRIP pin is 0.54 V. An additional 0.19 V DC-bias voltage is needed at the ITRIP pin
to meet the target current of 25 A. This is achieved by using resistor dividers R19 and R20 with 3.3 V supply.

The loce is calculated using:

R19
(Virrip+ — R19+ R20 ¥ 3.3V) * (R19 + R20)

R20 * Rshunt
=24934

locp =

Here, Virrip+ is the positive-going threshold for ITRIP and its typical value is 0.44 V, R19 = 100 Q, and R20 =1 kQ.

Note: If EVAL-M1-101T is not used as the controller board, an offset circuit needs to be added.
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2.1.5 Auxiliary power supply

The auxiliary power supply is derived from BM0650HV based DC-DC buck converter. The 12 V DC can be
connected an external Fan (not provided with the Eval board) for forced air cooling during prolonged testing.
The 3.3V power supply required for the IMC101T based MADK control card is derived from the 12 V DC using the
linear regulator IFX25001ME V33. This 3.3 V power supply is also used to bias different circuitry on board such as
the ITRIP config and CSO config. The auxiliary supply stage is as shown in the schematic in figure 27.

23~150V Input (Max2 1V~180V)

ji7)
- NC3 >
3

=]
+

3
D1 D2 +12V Ul IFX25001 V33 +3.3V @
[~ | 1 3 .

2 SW2VIN NC2 =l Izl 1 Q 4
SWIL/VIN NC1 ES1] ES1T % B
B VSSs VDD I
_l+c1 BMOB50HV L cs | c7
T 10uF 17 T 10uF 10uF LED3
_lcs | ca cé GREEN
T 220F D5 T 1000F 100nF 2
£ SS120
P 12V_FAN

Figure 17 A high voltage DC-DC buck converter provides 12 V followed by a 3.3 V generated from a
linear regualtor

2.2 Schematics

The schematics of EVAL-2ED2742S01G are shown in Figure 28

Figure 18 Circuitry of the power inverter board (main board)
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2.3 Layout

2.3.1 Layout details

Detailed layouts of the main inverter board are shown in Figure 19 to Figure 22.

o]
(&)
(&)
(o)
(o)
(o)
(o)
(o)
(o)
(o)

0]010]010I0I0 000

Figure 19 Power inverter board layout (All 4 layers togather)
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Figure 20 Power inverter board layout (Top view- layer 1)
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Figure 21 Power inverter board layout (Middle layer- layer 2)
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Figure 22 Power inverter board layout (Middle layer- layer 3)
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Figure 23 Power inverter board layout (bottom view- layer 4)
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Figure 24 Power inverter assembled board
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Both the schematic and layout files in Altium are provided on the 2ED2742S01G webpage online. Users can
download the same by logging in with their infineon.com credentials.
2.3.2 Layout guidelines
Some basic layout guidelines are as follows:
e TheVcc and Ves bypass capacitors should be close to the IC
o Thedrive loop should be as small as possible

o The loop of VSS and COM should be made as small as possible by connecting the VSS and COM directly
at the shunt-resistor terminals

e The two current-sensing traces should be started from the shunt terminals and placed close to each
other

2.4 Bill of material

The complete bill of material (BOM) is available in the Downloads section of Infineon’s homepage. A login is
required to download this material.

Table 5 lists the important components used in EVAL-2ED2742S01G.

Table5 BOM with Infineon components in Bold
Designator Comment Value Description Quantity
c1 10uF CAP / ELCO / 10uF / 200V / 20% / 1
Aluminiumelectrolytic / -25j3C to
105j3C/ 5.00mm C X 0.60mm W
10.00mm Dia X 21.50mmH / -/ -
C2 1nF CAP/-/1nF/25V/10%/X7R (EIA) / 1
-55jaC to 125j3C / 0603(1608) / SMD
/-
C3 4.7uF/50V Chip Monolithic Ceramic Capacitor 1
C4, C6 100nF Surface Mount Ceramic Capacitor
0.1uF 25V X7R 10%
C5, C7 10uF Chip Monolithic Ceramic Capacitor
Cc8 220uF, 25V CAP / ELCO / 220uF / 25V / 20% / 1
Aluminiumelectrolytic / -40j3C to
105j3C/ 3.50mm C X 0.60mm W
8.00mm Dia X 13.00mmH /- /-
a9 22nF CAP /-/22nF/ 250V /10% / X7R 1
(EIA) / -55iaC to 125iaC / 0805(2012)
/SMD /-
C11,C12, 1uF CAP/-/1uF/25V/10% / X7R (EIA) / 6
C13, C33, -55jaC to 125j3C / 0603(1608) / SMD
C34,C35 / -
C19, C20, 100nF Ceramic Capacitor 0.1uF 250V X7R 3
Cc21 10% SMD 1206
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C22 150uF CAP / ELCO / 150uF / 200V / 20% / 1
Aluminiumelectrolytic / -25i3C to
105iaC/ 7.50mm C X 0.80mm W
18.00mm Dia X 26.50mmH / -/ -
C32 1nF Surface Mount Multilayer Ceramic 1
Chip Capacitor
C38 10uF Chip Monolithic Ceramic Capacitor 1
D1, D2,D3 ES1) 1.0A Ultra Fast Recovery Rectifier 3
D4 BAV21W Surface Mount Fast Switching Diode 1
D5 SS120 Surface Mount Schottky Barrier 1
Rectifier, 20V
D6, D7, D8, 1N4148W-7-F Surface Mount Fast Switching Diode 6
D9, D10,
D11
D12 22V Zener Diode, 5% 22V 1
1 DC_INPUT PCB Terminal Block, Vertical, 5.08mm 1
Pitch; 2 pins
12 OUTPUT PCB Terminal Block, Nominal Current 1
16A, Nominal Voltage 250V, 5.08mm
pitch, 3 pin
13 M1 Socket WR-PHD 2.54 mm Angled Dual 1
Socket Header
17 12V_FAN Header, 2.54mm Pitch, 2 pin, 1
Vertical, Single Row
L1 330uH IND/STD/330uH/1.1A/10% / - 1
40j3Cto 125i3C/ 470mR / Radial /
Inductor, Radial;5.00mm C X 0.65mm
W 9.50mm Dia X 13.50mmH /- /-
LED1 DCBUS_OK Surface Mount LED, Green, 570nm 1
LED2 VCC_OK Surface Mount LED, Green, 570nm 1
LED3 GREEN Surface Mount LED, Green, 570nm 1
MP1, MP2, D00688 M3 X 10mm Pan Head, Cross Head 4
MP3, MP4 Metric Screw, 5.6mm X 2.4mm Head,
Nylon 6,6
MP11, 05.30.315 Hex-Standoff / Female - Female M3 / 4
MP22, 6 x 15 (DxH)
MP33,
MP44
Q1,Q2,Q3, | igfet_ n_ch_enh_dio_1s2s3s4g5d6d7d8d_8p | OptiMOS 5 Power-Transistor, 150 V, 6
Q4, Q5, Q6 N-channel
R1 1IMEG RES /STD / 1IMEG / 100mW / 1% / 1
100ppm/K / -55j4C to 155iaC / 0603
/SMD /-
R2 DNI Standard Thick Film Chip Resistor 1
R3 1k Standard Thick Film Chip Resistor 1
R4 5.1k RES /STD / 5.1k / 100mW / 1% /
100ppm/K / -55j4C to 155iaC / 0603
/SMD/ -
R11, R16 150k Standard Thick Film Chip Resistor 2
R12, R20 75k Standard Thick Film Chip Resistor 2
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R13, R14, 10R Standard Thick Film Chip Resistor 6
R15, R28,
R30, R32
R17, R18, 22R Standard Thick Film Chip Resistor 6
R19, R34,
R35, R36
R33 4.7k 4.7k/150V/1% 1
R40, R41 20mR Low Value Power Metal Strip Resistor 2
R43, R44 OR Standard Thick Film Chip Resistor 2
Ul IFX25001 V33 Low Dropout Voltage Regulator, 3.3V 1
Output
U2 BMO650HV PFM Controller and 200V Smart 1
power with high avalanche capability
MOSFET
U3, U4, Us 2ED274x 160 V half bridge SOI gate driver with 3
integrated bootstrap diode
2.5 Connector details
Table 6 Connectors
PIN Label Function
Various signal | X1 -X26 Test points for various onboard signals
input / output
DC+, DC- J1 DC power supply input
U/V/W J2 Three phase-outs (U/V/W) to the motor
M1 Socket - IMOTION™ MADK-M1 20-pin interface
M1 connector J3 connector
12V Aux output |J7 12V_FAN Header
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3

3.1

EVAL-2ED2742S01G is tested while running a custom BLDC motor in the setup shown in Figure 25.

System performance

System setup for running a BLDC motor

Test conditions:

e Input:Vy=48VvdC

e Phase-out current: lppase =25 Arms,

e Room temperature

e BLDC motor: Custom, lpnase= 25 A, test at speed = 52000 r/min

e Maximum heat sink temperature = 85°C after running for 30 min

e MOSFET temperature stable at 100 °C after running for 30 min

infineon

MADK Board

2ED2742S01G Eval Board
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Figure 25 System setup for running a BLDC motor
3.2 The output phase current
Error! Reference source not found. and 39 shows the waveform at light load and full load
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Figure 26 Current at light load
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Figure 27 Current at full load
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q References and appendices
4.1 Abbreviations and definitions
Table 7 Abbreviations
Abbreviation Meaning
IC Integrated circuit
MOSFET Metal Oxide Semiconductor Field Effect Transistor
DC Direct Current
BLDC Brushless Direct Current
PWM Pulse Width Modulation
EVAL Evaluation board
PCB Printed Circuit Board
SOl Silicon on Insulator
4.2 References

Infineon Technologies AG.
Infineon Technologies AG.
Infineon Technologies AG.
Infineon Technologies AG.
Infineon Technologies AG.

Infineon Technologies AG.

MOSFETs and IGBTs

Infineon Technologies AG.
Infineon Technologies AG.

Infineon Technologies AG.

motor drives

Datasheet of 2ED2742S01G

Advantages of Infineon’s Silicon on Insultor gate driver IC’s

Simulation mode of 2ED2742501G
Training videos of 2ED2742S01G

Application note: Managing Transients in Control IC Driven Power Stages

Application note; Use Gate Charge to Design the Gate Drive Circuit for Power

Application note: Using Monolithic High Voltage Gate Drivers

Application note: The New OptiMOS™ 5

Application note: Design guidelines for OptiMOS™ 5 in high power low-voltage

[10] Infineon Technologies AG. How-to-Measure-Motor-Parameters-Application Presentation

[11] Infineon Technologies AG. How to get started with iMOTION™2.0

[12] Infineon Technologies AG. Application note: From novice to expert with iIMOTION™ 2.0

[13] Infineon Technologies AG. Software Reference Manual: IMOTION™ Motion Control Engine

[14] Infineon Technologies AG. Application note: How to Use iMOTION™ Script Language
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Warnings

Due to technical requirements products may
contain dangerous substances. For information on
the types in question please contact your nearest
Infineon Technologies office.

Except as otherwise explicitly approved by
Infineon Technologies in a written document
signed by authorized representatives of Infineon
Technologies, Infineon Technologies’ products
may not be used in any applications where a
failure of the product or any consequences of the
use thereof can reasonably be expected to result in
personal injury.
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